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Abstract 

Mathematics uses a highly abstract set of symbols to represent its 

concepts and procedures. The accompanying verbal descriptions are not 

greatly less abstract and this makes the study of mathematics daunting 

for less courageous students. Readily available computer software can 

be leveraged to allow illustrations of mathematical techniques to real 

world situations using Modeling and graphical analysis. Our experience 

is that this can be a powerful motivating factor for university students to 

develop an appreciation of mathematics. 
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Introduction 

 

Mathematics can be considered from the perspective of a number of 

components. It takes an abstract form of symbol manipulation with little 

intuitive interpretation. The symbols represent abstract concepts, quantities or 

operations. The symbols also have an associated verbal language which in 

some cases are more intuitive than the symbols, but which also require 

learning. Then real world models, widely used in science and engineering 

research, can be found to which the symbolic process can be applied in a 

process which can give helpful meaning to the procedures represented by 

symbols. In the real world, a given mathematical procedure can be applied to a 

diverse range of models giving rise to the concept of the “Unifying power of 

mathematics” (Krezsig, 2011, p 69). Students can be motivated to learn and 

enjoy mathematics when learning and teaching moves beyond symbol 

manipulation and embraces verbal, graphical and Modeling approaches. 

 

This paper seeks to focus on readily available software which can be used to 

model mathematical processes either in graphical form or in the form of 

application to working real world models. In particular it will consider 

spreadsheet software (e.g. Microsoft Excel) as a useful Modeling tool 

(Neuwirth & Arganbright, 2004) and the freely available R language and 

environment for “exploring, visualising and understanding data” (Kabacoff, 

2011). Examples will be given to illustrate the way these tools can be used to 

illustrate the abstract world of mathematical symbolism and encourage its 

study. 
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Nature of mathematics 

 
Mathematics uses symbolism to represent abstract concepts originating from 

the analysis of space and time by the ancient Greeks. Modern Mathematics, of 

course, can represent a more abstract analysis of concepts beyond those of 

space and time. It can analyse the truth of logical procedures, for example, 

using set theory. However, for the learning of mathematics there are the aspects 

of language and unintuitive symbolism to be dealt with. Herein lies the 

difficulty of learning mathematics since, at first sight, mathematics appears as a 

new language comprised of abstract symbols only. However, this need not be 

the end process. Symbols which represent procedures or functions can be 

expressed using a readily available spreadsheet technology. Although not 

primarily a Modeling tool, a spreadsheet can be used, in the first instance, as a 

means of Modeling. Also the readily available R platform, although primarily a 

data analysis tool, can be used for graphical display of mathematical processes. 

 

Mathematical modeling 

 
A mathematical model is here understood to be a set of symbols and 

procedures of manipulation which can mimic aspects of a real world situation. 

Also the model is a simplified version of the situation with the introduction of 

simplifying assumptions to remove complications found in real world 

situations. With the advent of readily available computer technology both 

students, designers and inventers can inexpensively test their projects using a 

model under variations of component parts without having to build physical 

models or test the actual project the model represents. For example to test if the 

vibrations from a genset (electrical generator) in the basement of a building 

matches one of the resonant frequencies of the building, mathematics models 

would clearly be preferable.  

 

Using Excel as a modeling tool 

 

Excel is a well-known spreadsheet technology used primarily for data 

recording and analysis. However its wide range of mathematical functions and 

graphical tools make it a useful tool to introduce students to mathematical 

modeling and to explore details of mathematical processes. The model is built 

from a sequence of mathematical functions dependent upon quantities inserted 

into input cells. As well as being a useful testing tool for real world situations, 

it enables the student to explore the details of the mathematical process being 

modelled. Input values can be varied and output can be viewed as a numerical 

quantity or variation in a graphical display. Some examples of a Modeling 

process can now be considered. 

 

Modeling examples 

 

Financial Model 

Here we consider the case of investing money in a bank. If K50 was deposited 

as the initial deposit and the bank was to add 5% interest to that amount 
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annually, then to find the amount after 15 years using a spreadsheet, we begin 

by entering input data in cells (Figure 1). 

 

 
 

Figure 1 Input data has been entered. 

 

Having input the available data and created space for calculating years, interest 

and balance, we then proceed on with the calculating of years up to 15 (Figure 

2).  

 

 
 

Figure 2 Numbers from 0 to 15 are added. 

 

In the initial year there will not be any interest so the balance will be equal to 

the deposit but in the following years, the interest will be calculated as:  

=balance*interest rate. 

 

The new balance will be:  

= interest + previous balance. 

 

The calculation of interest and a new balance are now created (Figures 3 & 4). 

 

     
Fig 3: Interest is calculated. Fig 4: A new the balance is  calculated. 

 

Excel’s =FV (Future Value) function can be used instead of doing the above 

calculation to get the same result (Fig 5). 
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Figure 5 A short cut method finds the new balance after 15 years, using 

the =FV function. 

  

A graph showing financial growth over time can now be readily constructed 

(Fig 6).  

 
 

Figure 6  Financial growth with time is now presented. 

 

Furthermore, to make the presentation more interactive, a  scroll bar can be 

inserted which will be linked to the changing interest rate to show the variation 

in balance will if as interest rate is varied (Figure 7). 
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Figure 7 Scroll bar allows continuous variation of interest rate and the 

consequences of change can be explored. Figure 7 is repeated with 

interst rate of 5% being varied to 7%. 

 

Using the scroll bar to increase the rate from 5% to 7% will then produce the 

interest at year 1 to be K3.50 and the new balance will be K53.50 (Figure 7).  

We now turn to a physical model to interpret a simplified naturally occurring 

situation. 

 
Predator-Prey Model 

Here we consider the well-known Predator-Prey Model (Neuwirth & 

Arganbright, 2004, p. 68) which attempts to model how two inter-dependent 

animal populations grow and decrease over time as they interact upon each 

other and we discuss the factors that might cause the changes. 

 

This model is a study of predator (in this case fishermen) and prey (fish) in a 

certain fishing location.  The predator and prey populations don’t remain 

constant but can change in various  ways. For exampole, when there is no fish 

catching, the fish population will grow at an exponential rate (assuming 

unlimited food supply) but with fish catching, the fish population will decrease 

proportionaly to the size of the population of fishermen.  

 

The mathematical representation of these assumptions on the size of the fish 

population is:  

 

ChangeNumberOfFish 

 

= (InitialGrowthRateOfFish – PreyFactor * Fishermen) * Fish 

 

where the “PreyFactor” is the fraction of the total number of available fish 

caught per fisherman and where the variables “Fish” and “Fishermen” refer to 

numbers in the corresponding populations. The equation implies that increases 
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in the population of fishermen will cause a reduction from the initial or natural 

growth rate of the fish population.   

 

Similarly for the fishermen population we have the mathematical 

representation as: 

 

ChangeOfFishermenNumbers 

= (-InitialDimishingRateOfFishermen + FeedingRate * Fish) * Fishermen 

 

where the feeding rate is the fraction of the total number of fish caught per 

fisherman. The equation implies that increase in population of fishermen is 

dependent on the size of the fish population. If there are many fish then more 

fishermen will be attacted to the fishing location.  

 

Solving these two equations simultaneously will give the actual changes in the 

populations of fish and fishermen over time, given all these assumptions. The 

above equations for the model can be inserted into the spreadsheet model (Fig 

8). 

 

 
 

Figure 8 Initial data for the model are entered. 

 

Assuming there are 1000 fish and 100 fishermen in the first fishing period, we 

now calculate the change in numbers of fish and fishermen as shown using 

available mathematical functions (Fig 9). 

 

 
 

Figure 9 Changes in fish populaion are calculated. 
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Figure 10 Changes in numbers of fishermen are calculated. 

 

To obtain the number of fish and fishermen in a second period the calculations 

will be as follows: 

 

period   = 1 + 1,  

fish population = 1000 + change in size of fish population,  

fishermen population  = 100 + change in size fishermen population. 

 

From then on, the formulae will be the same for all the consecutive periods, so 

instead of repeating the calculations, the available drag down option can be 

used to calculate the new values (Fig 11). 

 

 
 

Figure 11 Population changes over time are displayed in table form. 

 

A 2 dimensional population graph of the model can now be displayed (Fig 12) 

showing oscillating changes in populations over a period of 1000 time 

intervals, a task hardly possible without the use of computing technology. 

 

 
Figure 12 Oscillating changes in the sizes of the two populations over 

1000 time intervals. 
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We can note that corresponding to a maximum point on one curve there exists 

a minimum point in the other. We can also note a phase shift or time lag 

between the two curves a minimum in the number of fishermen follows after a 

minimum of number of available fish as could be expected intuitively. Then 

when (slightly after) the population of fish increases the population of the 

fishermen will increase. That means that when the  fish population becomes 

large again, the fishing will resume (after a suitable time lag) and with the 

fishing activity the fish population will decrease. We note that the wavelength 

of succesive oscillations remains constant over time and that the amplitude pof 

oscillations increases over time. 

 

These outcomes can then lead to interesting discussions with students as to 

cause and effect. The effects of different input factors can be expored with 

immediate results, experiments which would not normally be feasible in a real 

population. Further, simplifying assumptions in the model (a characteristic of 

all models) could be explored. For example, the model assumes that if the fish 

population doubles, the number of fish caught per fisherman doubles, which 

might not always be the case. Also assumed are an unlimited supply of food for 

the fish population as it grows, and that fishermen are the only predators 

present thus ignoring the possible presence of sharks hunting for prey in their 

natural habitat. From all this students could conclude that the results of the 

model are largely qualitative rather that quantitative. However, they do 

correspond to what could be intuitively expected.  

 

We now show to the R platform as an alternative and powerful tool for similar 

modelling experiences. 

 

R platform 

 
The R platform is open source software designed by Ross Ihaka and Robert 

Gentleman about twenty two years ago and developed by dozens of volunteers 

(Everitt &. Hothorn, 2012).  Examples in R textbooks are fully reproducible 

and all analyses and results, including figures and tables, can be reproduced by 

the reader. R is designed as a statistical package and in theory that makes users 

think that it will be used for statistical purposes only, but there are much other 

functionality available using R. 

 

R’s graphical user interface 

 

R has a user friendly graphical user interface (GUI) as shown (Fig 13). When 

scripting, the scripts can be written on the R console or on an R editor which 

can be opened from File tab’s New Script option. 
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Figure 13 R GUI for scripting 

 

The tabs on R GUI (Fig 14) will help in carrying out many tasks. For example, 

the File tab provides commands for opening scripts, loading and saving 

workspace, the Edit tab provides commands such as the “Clear Console” and 

“Select Al”. The “View” tab has two commands, “Toolbar” and “Statusbar”. 

The “Packages” tab is important tab as it allows different packages for creating 

different types of graphs and calculations to be downloaded. 

 

 
 

Figure 14 shows the available tools and tabs in R GUI 

 

 R software can carry out mathematical calculations so long as a suitable script 

is written to provide correct instructions for the task to be implemented (Fig 

15). 

 
 

Figure 15 Simple addition using R script. 

 

Also, data stored in excel can be saved as a .csv file for importing into R and 

where it can be further displayed and processed. These data can be simply 

called for display or can be tabled or graphed (Figs 16 & 17).  
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Figure 16 Data is displayed    Figure 17 The data in Fig 15 is        

 in a .csv file.    read into R. 

 

The getwd() function (Fig 17) is used to display the folder in which the .csv file 

is located and the mydata=read.csv(file=”2.) line make assigns all data in the 

.csv file to mydata. names(mydata) is the script for outputting the headings of 

data in the .csv table. 

 

 

 
Figure 18 Presentation of a plot/graph of the data in Figure 16. 

 
The R software also allows the formatting of graphs created by adding colours 

to the graph and widening the thicknesses of planes that’s only to name a few. 

Here (Fig 18) the script line “plot(Malaria, Asthma, col=”red”)” sets the colour 

of the point circles to red. Further examples of R as an analytical and graphical 

tool will now be provided. 

 

Using R as an analytical and graphical tool 

 
R as an analytical tool can be used in Linear Algebra for the creating of a 

matrix and for the calculation of the matrix’s determinant (Fig 19). 
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Figure 19 R is used in a linear algebra exercise to calculate the 

determinant of a matrix. 

 

R can also be used as a graphical tool with the ability to allow different 

libraries to run in it. Thus, it can be used in probability and statistics to produce 

histograms and normal curves for showing some data and its frequencies. 

Suitable coding or scripting (Figure 20) can be written to produce a histogram 

and normal curve (Figure 21). 

 

 
Figure 20  R scripting to produce the graphing in Figure 20). 

 

The script (Figure 20) has R produce a graph with the following characteristics 

(Figure 21). The histogram shows 20 red columns along the x-axis. The title of 

the graph will be “Histogram with normal curve and box”. The x lable of the 

graph is “Number of students in a class and the normal cuve with a blue line 

and a box with the default color black all around the histogram. 
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Figure 21 is a display/the output of Fig 20. 

 

The above examples have demonstrated that mathematics at university level 

can be illustrated, graphed and modelled with various readily available 

software tools. These have the power to introduce different ideas, subjects and 

approaches.  

 

The unifying power of mathematics  

 

Not only can mathematical procedures be modeled and illustrated using diverse 

available software as shown in this paper, but a given mathematical procedure 

can have a wide range of modelling applications. Various authors of 

mathematics text books (eg. Krezsig, 2011) emphasise for students the value of 

basic mathematical concepts, principles and procedures in explaining and 

Modeling a wide range of applications. A single mathematical equation can be 

applied to a wide range of applications.  

 

“Entirely different physical systems may have the same mathematical 

model and thus may be treated by the same mathematical methods”. 

(Krezsig 2011, p. 566) 

 

An example often used is the second order linear ordinary differential equation 

Modeling vibrations in nature, machinery or musical instruments. This will be 

the subject of a forthcoming paper in this series on the use of mathematical 

Modeling both to explore real world situations and to motivate students to 

appreciate the power and value of mathematics. 

 

Summary and conclusion 

 

This paper has proposed Modeling and display of mathematical procedures as a 

means for motivating university students to learn and enjoy mathematics, as 

well, of course, for explicating mathematical processes. It has proposed 

spreadsheets as a readily available and powerful tool for Modeling 

mathematics. It has also demonstrated with simple examples the use of the 

freely available R platform as a scripting language to demonstrate and graph a 

wide range of mathematical procedures. 
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Similarly it has further noted the applicability of a single mathematical 

procedure to a wide variety of real world appreciations giving rise to the 

appreciation of the unifying power of mathematics.  
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